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20. D&C Manager – Additional Functions 
In this exercise we will demonstrate other ways to use D&C Manager, to control 
graphics displayed, cell access and quantity calculation from graphics. 

I.) Display Control 

1) Open the MicroStation file  

C:\Projects\Roane\SR95PoplarCr\ROSR95Proposed.dgn 

2) Go to File → References and turn on the display of the Survey topo and 

Alignments DGN files. Fit the view so that all graphics are showing. 

3) Access the D&C Manager. 

Select the item Drafting Standards → Roadway Linework → EOP Prop  

4) Set Display mode in Design and Computation Manager. In the expanded dialog, 

click on the Display icon (computer screen view divisions) which will open up the 

Display control tool box. 

 

 

NOTE:  

In D&C Manager’s tool box mode the Display control icons are shown always and 
you can pick them as needed. 

5) The different display control icons change display for a D&C Manager item or items 
as follows: 

Normal Display   all graphics are shown 

Highlight Selection  items are highlighted 

Hide Selection   items are turned off 

Display only Selection only items are shown 



20-2 D&C Manager – Additional Functions GEOPAK Road Course Guide 

Try the different modes out while you have EOP Prop selected. You may need to 

zoom in on the plan view graphics. 

NOTE:  

One of the best uses for the Display functions are to check graphics such as 
pavement lines or guardrail items when they are not being reflected in cross section 
runs. The Display controls can show you immediately if graphics are not set at the 
correct level or symbology. 

6) Back in D&C Manager, select the category Drafting Standards → Guardrail. 

Select the last display icon, Display only Selection. 

 

Now only the guardrail items placed previously are showing. 

7) Select the item Drafting Standards → Guardrail →GR Single Prop. 

 

Now only that guardrail item should be showing. 

In case you haven’t discovered this by accident, if you double click on an item in 

D&C Manager’s expanded mode then it is added to a collection box at the bottom. 
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This way you can pick several different items for the Display functions to work on. If 

you right click in the collection area then you will get options to Clear the collection, 

Save it or Open one saved previously. 

8) Try adding different items under guardrail to the collection box and experiment with 
the Display controls to check the results. 

 

9) Right click in the collection area at the bottom of D&C Manager and pick Clear 

Collection. Select the Normal Display mode so that all graphics are showing 

again. 

II.) Cell Access 
The T.D.O.T. Roadway Design Division cell libraries provide over 1200 standard 
cells. Although GEOPAK does provide tools for placing individual cells defined as 
items in D&C Manager, it is just not feasible to set up so many that way. Instead we 
have MicroStation visual basic applications called from D&C Manager which access 
groups of cells. 

In this exercise we will look at the cell access dialog for Traffic Control Device Cells 
to illustrate how these cell dialogs function. 

1) Access D&C Manager and set mode to Design. 

2) Double click on item  

Drafting Standards → Traffic Control (Temporary) → TC Device Cells 
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The Traffic Control Device Cells dialog is opened. 

 

All cell dialogs are in this same basic format, a cell pick list by description on the left 
with a viewing window on the right.  

At the bottom left of the dialog is the Cell Placement Type option.  

A “window shade” minimize button is located on the upper right.  

The Restart Cell Place command button at the upper left can be used anytime 

other MicroStation commands have been used and you wish to go back to placing 
the currently selected cell. 

Also included at the bottom are other special programs that might be needed or 
used in conjunction with these cells. In most cases the special tool options on cell 
dialogs are also accessible from D&C Manager directly. 

3) When a cell is chosen from the list, the cell is made active and placement is started. 

The method of cell placement depends on the Cell Placement Type which is set 

at the lower left. The default value for this option varies and is set to the most 
common one needed for the cells from the dialog. 

Click on the Cell Placement Type button and review the options which are 

described here: 

 
Simple Place places cell with MicroStation’s Place Cell command with 

settings for angle and scale 
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Place/Rotate places cell by data point with dynamic rotation and 

setting for scale 

Place Along places cells along an element with settings for spacing, 

scale and angle 

Place Sign With … available on the sign cell dialogs, includes placement of 

sign face with text label, leader line and sign symbol 

The Traffic Control dialog defaults to Place/Rotate but instead of using that method 

click on the option button and set it to Simple Place.  

4) Scroll down the cell list and pick any cell. MicroStation’s Place Cell command is 
started. Adjustments can be made for angle and scale prior to placing cell as needed 
using these basic controls. 

 

Data Point to place the cell. You may need to turn on level, DESIGN - TRAFFIC 

CONTROL TEMPORARY – Devices, to see the cell. 

5) Click on the Cell Placement Type button and set it to Place/Rotate. 

Pick another cell from the list. The Place Cell & Rotate dialog opens where you 

can adjust the scale as needed. 

Data point in graphics at a location for the cell. Rotation is started so that the 

angle can be set dynamically. 
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Data point to set the angle and place the cell.  

The Place Cell command button on the Place Cell & Rotate dialog can be used 

anytime other MicroStation commands have been used and you wish to go back to 
placing the active cell with dynamic rotation 

6) Click on the Cell Placement Type button and set it to Place Along. 

Scroll back up in the cell list and pick the cell Barrel – Left. The Place Cells 

Along Element dialog opens where you can make control settings as needed. 

Set the control settings as shown below: Spacing 55, Scale 50 & Angle 0. 

 

Click the Place Cells Along command button.  
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In the prompt field of the MicroStation status bar, we are being prompted to 

Identify Element at beginning location. Data point anywhere along our 

inside edge of pavement on the right side of the roadway. 

Once the line is identified, we are prompted to Accept/Reject …Identify 

direction\end. Accept the pavement line element to the right. 

Barrel cells are placed on the 55’ spacing along this line between the points given. 

 

NOTE:  

For the user’s convenience all cell dialogs are available through the following 
locations: 

D&C Manager items as illustrated in this exercise 

T.D.O.T. drop down menu from the MicroStation menu bar with TDOT 

interface active 

TDOT Design Division Tool Box special tool box with many commonly used 

functions including GEOPAK & 
MicroStation tools as well as customized 
T.D.O.T. Roadway Design Division tools.  
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The TDOT Design Division Tool Box is available from MicroStation menu bar at  

T.D.O.T. → Tools → Design Division Tool Box 

 
or from GEOPAK’s D&C Manager at  

Drafting Standards → Tools → Design Toolbox 
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III.) Quantities 

1) Access the D&C Manager. 

2) Select the category Pay Items → Guardrail Items 

3) Set Compute mode in Design and Computation Manager. In the expanded dialog 

click on the Compute icon (small calculator) which will open up the Plan 

Quantity Computation dialog. 

 

4) Make sure the Job is set to 101 and Extents is set to View.  

Set the Baseline Reference to None and toggle on the Highlight During 

Computation option 

 

5) Adjust your View 1 as needed so that our guardrail is shown there. Turn on level 

DESIGN - TRANSPORTATION - Roadside Barriers and refit the view so 

that you see the guardrail on the left around station 290+00.  

6) Click on Compute Quantities. The graphics are read and the Computation 

Results dialog is opened with the totals for items under the selected category. 
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In the MicroStation view, the guardrail items are marked with your highlight color. 

 

NOTE:  

The quantities displayed in the Computation Results dialog can be saved to a 

CSV file (comma separated values) which can then be used to import quantities 
directly into the Estimated Roadway Quantities Excel worksheet. In the 

Computation Results dialog set Export Format to CSV By Item, keyin a 

filename and click Export.  

7) Since we need station limits for our guardrail tabulations let’s try a different set up. In 

the Plan Quantity Computation dialog set Baseline Reference to Chain and 

chain SR95 as shown. The Range setting is used to make sure items on other 

roadways are ignored and Stations can limit the area of the specified roadway as 

well. 

 

8) Click on Compute quantities. In the Computation Results dialog set Export 

Format to Comp Book, keyin the filename SR95guardrail.txt and click 

Export. 
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9) Use GEOPAK’s text editor to open the file SR95guardrail.txt and review the 

results of your latest computation. 

 

NOTE:  

Guardrail quantities generated in this way can be used to automatically build the 
data into our standard tabulation format using the program available in standard 
Microsoft Excel template 

C:\Users\Public\OfficeStandards\TDOTEnglishTabQuantities\Guardrai

lTabBuilder.xltm.  

Before making any changes to this file, use “save as” to save it into 

your working directory so you do not alter the template. 
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10) In the Working Directory. double-click to open  file  GuardrailTabBuilder.xls  

 

  

11) Select the option  Build Guardrail Block , go to Working Directory and select 

and open SR95guardrail.txt 

 



Exercise 20 

GEOPAK V8i (SELECT Series 2)  D&C Manager - Additional Functions   20-13 

         Select File – Save to save Proposed Guardrail tabulated block to Working 

Directory 

12) Tabulated block can be placed in a Microstation dgn file by dragging the cursor over 

the block to highlight it, right –click to “copy”. Then go to dgn file , select  Edit – 

Paste Special, Linked Microsoft Excel 2003 Worksheet  

           

          Select Paste, then By Corners 

           

  

13) Experiment with different modes and export options to familiarize yourself with the 
computation functions.  

If you wish, calculate some quantities on the traffic control devices placed in 

the previous exercise or perhaps the 6-30 C&G we placed in the urban section at 

the end of the project. 

For the curb and gutter, you can use a rate of 0.07181 cubic yards of concrete per 

foot which would be used for a gutter thickness of 9”. The user is prompted for this 
rate on each C&G element that is found. It will remember the last rate entered so 
you only have to key it in once and can just accept it on subsequent elements.  

Refer to standard roadway drawings RP-MC-1, RP-MC-2 and RP-NMC-10 for 

applicable rates of concrete per linear foot for curb and gutter. 
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As was illustrated with the Display functions at the beginning of this chapter, a 

Collection area is set up at the bottom of D&C Manager when in Compute mode 

to allow the selection of various items from different categories under Pay Items.  

NOTE:  

Only D&C Manager items under the Pay Items category are set up for quantity 

calculation from graphics. 

14) Exit the Plan Quantity Computation dialog and Design and Computation 

Manager. 




